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1 Information about the result files

1.1 WUFI® Pro

Beginning with version WUFI® Pro 6 the program WUFI Graph is available for results evaluation.
An evaluation with WUFI Graph is only possible if the WUFI® Pro project file includes the film
data. The options for saving the film data can be changed in WUFI® Pro in the menu “Options”
→ “Result Data”.

1.1.1 Open a WUFI® Pro project file from WUFI Graph

In WUFI Graph goto menu “File” → “Open WUFI result file...” and select the needed project file
(*.w6p). This way, all saved and calculated cases in the project file are opened in WUFI Graph.
Additionally the quick graphs from WUFI® Pro are displayed in the section of result files as predefined
diagrams.
Trying to open a project file without film data, the following error message appears in WUFI Graph:

1.1.2 Open a project file from WUFI® Pro

Calculated cases can be opened in WUFI Graph by pressing the WUFI Graph-button. The selected
case as well as the quick graphs from WUFI® Pro are displayed in the Result files section as predefined
diagrams.

This process can be repeated with further cases (see Open multiple project or result files in WUFI
Graph).

Note: If a case which was directly opened out of WUFI® Pro is still open in WUFI Graph, a
recalculation of this case is not possible. For recalculation the project file have to be close in WUFI
Graph.
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1.2 WUFI® 2D

An evaluation of WUFI® 2D result files in WUFI Graph is only possible for quantities which were
selected in the WUFI® 2D project file before calculation (“Computational Parameters” → “Result
File contains”). Only these quantities are saved in the result file.

The following result quantities can be selected in WUFI® 2D:

W.C.: water content

R.H.: relative humidity

Temp.: temperature

Va.P.: vapor pressure

Flu.C.: capillary moisture flow

Flu.D.: vapor diffusion flow

Flu.H.: heat flow

1.2.1 Open a WUFI® 2D result file from WUFI Graph

Open WUFI Graph and select the desired project file (*.wfd) from “File” → “Open WUFI result
file...”. All quantities saved in the project file can be evaluated in WUFI Graph. The total water
content is displayed as pedefiniton in the Result files section.

1.2.2 Open a result file from WUFI® 2D

Using the WUFI Graph button (Launch result viewer) WUFI Graph can be open during and after
the calculation.

This procedure can also be repeated with further WUFI® 2D result files (see Open multiple project
or result files in WUFI Graph).

Note: Opening WUFI® 2D result files in WUFI Graph during a calculation is running, single er-
roneous values may occur (e.g., jumps to zero).
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1.2.3 Open a WUFI® 2D result file from WUFI2DMotion

It is also possible to start WUFI Graph out of WUFI2DMotion during and after the calculation with
the help of the Button “Launch result viewer”.

This procedure can also be repeated with further WUFI® 2D result files (see Open multiple project
or result files in WUFI Graph).

Note: Opening WUFI® 2D result files in WUFI Graph during a calculation is running, single er-
roneous values may occur (e.g., jumps to zero).

1.3 Open multiple project or result files in WUFI Graph

For a comperative evaluation or presentation multible project or result files can be opened in WUFI
Graph. If the results are opened from other programs (WUFI® Pro, WUFI® 2D, WUFI2DMotion),
WUFI Graph checks, if it is already running and if so the user will be prompted to select the whether
the data should be open in a new instance of WUFI Graph (new project) or integrated in an existing
one.

1.4 Supported file formats

WUFI Graph can process the following file formats.
WUFIGraphs own formats:

*.w2g WUFIGraph Project

*.w2t WUFIGraph Template
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*.w2g.xml WUFIGraph Project (Former format used up to WUFI Graph 2.4.x)

*.w2t.xml WUFIGraph Vorlage (Former format used up to WUFI Graph 2.4.x)

Result and project files which can be open for evaluation in WUFI Graph:

*.w6p WUFI® Pro 6 Project - all calculated cases will be imported (see also “Result Data”)

*.wfd WUFI® 2D 3.x and 4.x Result file (see also “Result file contains”)

Project files from older versions of WUFI® Pro are not supported (e.g., *.w4p, *.w5p).
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2 Main Window

The main window is divided into three sections: Top left under “Result Files” is a list of open result
files with the predefined evaluations; on the bottom left the “User defined” reports are displayed,
each as a tree structure. The large window on the right side shows the compilation selected on the
left side directly as “printable” view.
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2.1 Main menu

2.1.1 File

Note: If the use of individual menu items is not possible, they are grayed out and cannot be clicked.

Open Graph project <Ctrl-O>
Displays a dialog to open saved Graph projects (also see Supported file formats).

Reopen Graph project
Here, the most recently edited Graph projects can be selected from a list for quick re-opening.

Close Graph project
Close the currently opened or created Graph project.

Save Graph project <Ctrl-S>
Saves the currently opened Graph project. WUFI Graph uses the file extension *.w2g.

Save Graph project as. . .
Saves the currently opened Graph project using a new name. WUFI Graph uses the file
extension *.w2g.

Load template. . .
Loading a WUFI Graph evaluation template.

Save as template. . .
Save the current compilation as WUFI Graph evaluation template.

Open WUFI result file. . .
Open a WUFI® result file for evaluation in WUFI Graph. Several result files for paral-
lel/comparative evaluation can be opened. Supports result files of file formats *.w6p (WUFI® Pro 6.x)
and *.wfd (WUFI® 2D 3.x and 4.x).
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Close WUFI result file
Close the results file currently highlighted in the Result files window.

Page setup. . .
Setting up the paper size, margins and orientation for display and printing.

Print selected. . .<Ctrl-P>
Print the selected page. This opens the standard Windows printer menu.

Settings. . .
Here the basic Settings of WUFI Graph can be changed.

Exit <Alt-F4>
Close WUFI Graph. In case of unsaved changes/projects the user is prompted for save before
closing.

2.1.2 New page

This selection allows to create a new user defined page that contains a chart containing the selected
result type. It opens the “Area Selection / Settings” in which the area, range and settings for
creating the graphic can selected.
The following result types for evaluation are available:

Temperature
Adds a new page with a temperature curve.

Relative humidity
Adds a new page with curve of the relative humidity.

Water content
Adds a new page with a course of the water content. The following output units are available:

• Water content [kg/m2] (nur WUFI® Pro)
• Water content [kg/m3]
• Water content [M.−%]
• Water content [V ol.−%]

Isopleths
Adds a new page with an isopleths diagram (showing the relative humidity printed against the
temperature for each time step).
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Average flux density (only WUFI® 2D)
Adds a new page with a course of the average flux density. The following output units are
available:

• Heat flux density [W/m2]
• Diffusion flux density [kg/m2 s]
• Capillary flux density [kg/m2 s]

Flux (only WUFI® 2D)
Adds a new page with the course of flows. The following output units are available:

• Heat flow [W/m]
• Diffusion flow [kg/m s]
• Capillary flow [kg/m s]

WTA 6-8
Adds a new page with an evaluation according to WTA-Recommendation 6-8. The following
selections available:

• Wood moisture WTA: Evaluation of the relative pore air moisture content in the selected
layer.

The following two diagrams are developed in accordance to the WTA-recommendation 6-8,
though they are not included in the recommendation.

• Water content [M.−%(mv)]: Daily mean value of water content in selected layer.
• Limit water content [M.−%(mv)]: Limit curve according to WTA-recommendation 6-8

displayed as course of limit water content for the selected material.

User defined
User defined definition of the course.

Isoline (only WUFI® 2D)
3D display of result quantity as isolines over the selected range. The following result quantities
can be displayed:

• Temperature [°C]
• Relative humidity [%]
• Water content [kg/m3]
• Water content [M.−%]
• Water content [V ol.−%]
• Vapor pressure [hPa]

The isoline is always generated and displayed on a separate page and is therefore not in the
selection of new diagrams.

Note:
WUFI® Pro: The output of fluxes (Average flux density/flow) is currently not possible. Isoline is
not available.
WUFI® 2D: Only quantities can be evaluated which are saved in the result file, otherwise they are
grayed out in the menu (see also “Result file contains”). The display of water content in kg/m2 is
not available.
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2.1.3 Current

Using this menu, a new graph can be added to the selected location. The same menu appears
performing a right-click in user defined menu (on the page, diagrams, graphics . . . ).
If there is no entry existing in the user defined section, a new page is created. In this case the
menu is similar to “New page”.

If a page is selected, a new diagram is added to this page. All entries in the menu containing the
prefix “add”:

Additional to the possibility to insert a new diagram the following functions are available:

Rename
Allows to change the page name.

Delete
Deletes the currently selected page with all diagrams (Attention: deleted pages can not be
restored).

Refresh
Rereads the data of the selected page. This is necessary especially when previously reading of
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the curves were canceled using ESC.

Export
Here the page can be exported to the printer (“Print”) and saved as file (“as picture”).

If a diagram is marked, the selected result type will be added in it as a new curve. In this case
the result types in the list are completed with “Add . . . series”:

Additional to the possibility to insert a new curve the following functions are available:

Chart settings
Here the Chart settings (scaling, reference line, curves, colors, etc.) can be changed.

Rename
Allows to change the diagram name (corresponding to the diagram title).

Delete
Deletes the currently selected page with all diagrams (Attention: deleted pages can not be
restored).

Refresh
Rereads the data of the selected page. This is necessary especially when previously reading of
the curves were canceled using ESC.

Export
Allows to export the values of the series contained in the diagram as an ASCII file. The page
can be exported to the printer (“Print”) and saved as file (“as picture”).

After selecting a series in the “User defined” section, the menu “Current” (or right mouse click)
shows the following possibilities:
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Options
Opens the Area Selection / Settings window. Here the settings for data source of the series
can be changed.

Rename
Allows to change the series name (corresponding to the label in the legend).

Delete
Deletes the currently selected series.

Refresh
Rereads the data of the selected series. This is necessary especially when previously reading
of the series was canceled using ESC.

Export
Allows to export the values of the series contained in the diagram as an ASCII file. The page
can be exported to the printer (“Print”) and saved as file (“as picture”).

If an entry is highlighted in the “Result files” section, the following functions are available:

Refresh
Rereads the data of the selected page. This is necessary especially when previously reading of
the curves were canceled using ESC.

Export
Here the page can be exported to the printer (“Print”) and saved as file (“as picture”).

If an isoline in the “User defined” section is marked, the following functions are available:
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Options
Opens the “Area Selection / Settings” window. Here the settings for data source of the isoline
can be changed.

Delete
Deletes the currently selected page with all diagrams (Attention: deleted pages can not be
restored).

Export
Here the page can be exported to the printer (“Print”) and saved as file (“as picture”).

2.1.4 Help

The menu “Help” contains the following possibilities for selection:

WUFI-Graph Help
Opens the WUFIGraph program help.

Direct Help
Direct help on a topic chosen by mouse click.

About
Credits about version and developers. Furthermore, links to the programs log files can be
found here.
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2.2 Section Result files

In the section “Result files” opened result files and predefined pages are displayed as a tree structure.
The result file is shown as the parent unit followed by predefined result pages (pages depend on the
result file).
The currently selected project are displayed in italic and underlined.
For WUFI® Pro the quick graphs are predefined (e.g., total water content, water content in layers,
temperature and relative humidity at the monitor positions etc.).
For WUFI® 2D result files the total water content of the construction is predefined.
Depending on the selection in the tree structure, the display in the “Section Page” changes. The
following options are available:

Selection of file names (*.w6p and *.wfd)
Displays the project information contained in the result file (if entered in WUFI)

Selection of case names (WUFI® Pro only)
Displays information about the selected case and about the last run of calculation. The start
date can be adjusted to compare results with different start dates in the same diagram.

Selection Diagram
Displays the selected diagram in the “Section Page”.

After selecting an entry in the “Result files” section, the menu “Current” (which also appears by
clicking the right mouse button on the entry) opens with the following possibilities:

Refresh
Rereads the data of the selected page. This is necessary especially when previously reading of
the curves were canceled using ESC.
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Export
Here the page can be exported to the printer (“Print”) and saved as file (“as picture”).

Note: If a result file is not found during loading a Graph project, the filename is displayed in red
color. By left-clicking on the red name. A window opens where the new path of the result file can
be selected.
Series or diagrams in the tree structure can be copied into the “Section User defined” by dragging
them there.

2.3 Section User defined

In the “User defined” section, own pages can be compiled with own result evaluations. This can
be done by either choosing “New page” and “Current” from the menu or by clicking on the wished
position using the right mouse button:
Right mouse click in empty area in the “User defined” section ⇒ menu “New page”
Right mouse click on an entry in the “User defined” section ⇒ menu “Current”.
By adding new curves in pages or diagrams a tree structure is created. Parent root is always the
page on which one or more diagrams can be inserted. The diagrams can contain multiple series.
Other mouse functions available in the tree structure:

Move entries:
Dragging with the mouse can move series and diagrams to other position in the tree structure.

Copy entries:
Pressing Ctrl and dragging with the mouse can copy series and diagrams to other position in
the tree structure.

Menu:
Right mouseclick opens the menu “Current”

The following picture shows an example of a user defined tree structure:
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If a new course is added into the empty area, a new page and a new diagram is created. Should a
page be selected, a new diagram with the series is generated. If a diagram is selected the new
series is added into it. If the selected result quantity is in the same unit as an existing series, the
existing range axis is used for scaling. Otherwise, new range axes are displayed for the new series
on the right side of the diagram.
In the following example temperature 1 and 2 are shown on the left axis, water content and relative
humidity are shown on two axes on the right side of the diagram.
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Note: The Isoline is excluded from the tree structure. For each Isoline a new entry is created in the
root of the in tree structure.

2.4 Section Page

The content of the page depends on the selection made in the left two sections (“Result file” and
“User defined”). By selecting an entry in Section Result files the course is shown in a full page
diagram. In the Section User defined, by selecting an entry of the branch “page”, a page with all
diagrams is displayed. The selection an entry of the branches “diagram” or “series” leads to a display
of a single page diagram.

2.4.1 Page display

If an entry from the predefined diagrams or a user defined diagram in is selected, is displayed
filling the whole page:
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2.4.2 User defined page

Selecting a user defined page shows the page with all created diagrams.
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2.4.3 Diagram functions

It is possible to zoom in and move the diagrams:

Zoom in:
with the mouse wheel or draw a rectangle from top left to bottom right.

Zoom out:
with the mouse wheel or draw a rectangle from bottom right to top left.

Move/Pan:
Strg + left mouse click.

For the selected diagram the following actions are possible choosing the menu “Current” (or perform
a right mouse click on the displayed diagram):
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Chart Settings
Here the Chart settings (scaling, reference line, curves, colors, etc.) can be changed.

Refresh
Rereads the data of the selected page. This is necessary especially when previously reading of
the curves were canceled using ESC.

Export
Allows to export the values of the series contained in the diagram as an ASCII file or to save
the diagram as a picture.
For diagrams containing a single series of the “Module: X-Y-Plot over selection” (e.g., Type:
Wood moisture WTA, Type: Isopleths), an export for postprocessors can be selected.

Copy
Copies the current page to the clipboard.

2.4.4 Export for post-processing

For diagrams created with the “Module: X-Y-Plot over selection” (e.g., Type: Wood moisture
WTA, Type: Isopleths), the data can directly be saved for further use in postprocessors or directly
be opened in a postprocessor.
Note: Exporting to postprocessors is only possible if the diagram contains only one series of the
module “X-Y-Plot by selection”.
The following functions are available additionally in the export menu (see also Diagram functions):

as file for WUFI® post processor
Outputs an ASCII file in a format which is readable for the WUFI® post-processors. The file
can then be opened manually in the needed post-process module.

open in WUFI® postprocessor
This directly opens the selected post-processing module and passes the data from the diagram
for further processing.
WUFI Graph detects the installed post-process modules and shows a list entry for each detected
one.

You can find more information about the post-process modules for WUFI® on the WUFI® website:
https://wufi.de/en/software/wufi-add-ons/
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2.5 Isoline (only WUFI® 2D)

The isoline allows a two-dimensional bird view or a freely rotatable display of values of equal size.
The mean value of the given range is drawn as a line in the grid.
Further information for creating an isoline can be found in Type/Module: Isoline.

2.5.1 Functions in the display of Isolines

The diagram can be rotated by grabbing it with the mouse cursor and dragging it into the desired
view. For this purpose the rotation axes can be set on the right side below the legend:

x-z The rotation is performed around the x and z axes, the y-axis does not change.

x-y The rotation is performed around the x and y axes, the z-axis does not change.

reset
Resets the rotation to the plan view.
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By rotating the mouse wheel the construction can be zoomed in or out. By holding the Ctrl
key simultaneously and pressing the left mouse button, the image can be shifted.

Keyboard features
The isoline diagram offers a few further functions which can be accessed via the keyboard:

Arrow keys (numpad)
scroll the diagram in the respective direction.

5 (numpad)
reset diagram.

Page Up
zoom into diagram.

Page Down
zoom out of diagram.

Mode selection

Alt + z
switches to mode ZOOM.

Alt + v or Alt + t
switches to mode SCROLL.

Alt + r
switches to mode ROTATE.

Alt + s
shows the currently active mode.

x, y, z
applies the currently active mode with the respective increment to the x-, y- or z-axis.

Shift + x, y, z
like x, y, z, but negative.

+, - (Numpad)
increases or decreases the increment.

Scaling
The scaling and the colors of the lines can be accessed by right clicking on the legend. A
“Settings” button appears:

In the appearing menu “Isoline” the ranges and colors of the lines can be defined:
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In this table, the ranges of the values for displaying the line and the colors for the single lines
can be changed. The color can be customized for the individual ranges.

Constant dx
Here the range and values between the lines can be defined.

Linearize colors
By pressing this button, a color gradient between the first and last color (here 1 and 10) is
applied.
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3 Chart settings

In the chart settings, scaling of the axes and the order of presentation can be changed. Furthermore,
it is possible to add reference lines to the series.

3.1 Tab: Domain axis

Start
Start value for the domain axis. The value above the field is showing the minimum value from
the result file.

End End value for the domain axis. The value above the field is showing the maximum value from
the result file.

Unit
Unit for time used for the interval of the axis scale. The interval itself can be defined in the
field dX.

dX Interval for the subsection of the axis scale. The corresponding unit is set in “Unit”.

Autoscale (Preset: activated)
If automatic scaling is enabled, the values in the “Start”, “End”, “Unit” and “dX” are set
automatically depending on the values in the result file. If automatic scaling is disabled, these
values can be set by the user.

Label
Label of the domain axis for displaying the diagram.

Date format
Date format used for labeling the axis.
Note: Further date formats can be defined in the Settings.
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3.2 Tab: Range axis

Here, the scale for the range axis can be adjusted. If a diagram shows several range axes, a separate
tab for each axis is shown.

Start
Start value for the domain axis. The value above the field is showing the minimum value from
the result file.

End End value for the domain axis. The value above the field is showing the maximum value from
the result file.

dY Interval for the subsection of the axis scale.

Autoscale (Preset: activated)
If automatic scaling is enabled, the values in the “Start”, “End”, “Unit” and “dX” are set
automatically depending on the values in the result file. If automatic scaling is disabled, these
values can be set by the user.
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3.3 Tab: Series

3.3.1 Tab: Series order

Here the order of the series can be set. The top series in the list is shown in the foreground of the
diagram. The position of the selected series can be changed by using the buttons “up” and “down”
or by drag and drop.

3.3.2 Tab: Series

For every series in the selected diagram a tab is shown. Here the settings for color, line, etc. can
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be changed.

Label
Label for series, which is displayed in the legend.

Color
Color for series.

Line Here the line type can be changed for display.

Width
Line thickness for the display of the curve.

Reference values
To insert reference lines for an existing series.

3.3.3 Add reference line

Select a diagram, go to the menu “Current → Options” or do a right click on diagram and select
“Options”. The menu chart settings opens.
Change to the tab “Series” and select the sub-tab “Series: x” (x is the n umber of the series to add
a reference line, here 1 is chosen).

In the section reference line and press “Add”. A new entry in the table appears for editing the
reference lines properties:
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In the table the “Name”, “Value”, “Color”, “Style” and “Width” can be adjusted for a reference
line. In the example a blue broken line with a width of 3 and the name “Ref. line 1” is added at a
value of 75.
For one series multiple reference values can be defined.
Reference lines can be deleted by selecting the corresponding entry in the table and press the
“Remove” button
By pressing “Ok” or “Apply” the changes are applied to the diagram.
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4 Area Selection / Settings

In the upper area, the assembly is displayed with its computational grid. Here the grid elements
for evaluation can be selected by clicking with the mouse. The following functions are available in
assembly:

Left mouse click
selection/deselection of the grid elements, by drawing a rectangle with holding the left mouse
button pressed, whole areas can be selected/deselected.

Right mouse click
The following menu appears:

Select material
Selects all grid elements of chosen material.

Select all
Selects all grid elements of the assembly.
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Deselect all
All selections are removed.

Export assembly
The following options are available:

• View as picture
• Assembly as picture
• View to clipboard

Shift + left mouse click
Zoom in: draw a rectangle from top left to bottom right
Zoom out: draw a rectangle from bottom right to top left

Ctrl + left mouse click
Shift the view of assembly (only if zoomed in)

In the line below the selection window the pull-down menu “File”, “Type” and “Module” as well as
the check box “Combined selection (1 cm)” are available.
The pull-down menu “File” allows to select the source file for the series from the opened result files.
With the pull-down-menu “Type”, the output type can be changed. Note: If this is changed here,
the output type no longer corresponds to the one selected in the menu “Current” or “New page”.
The following types are available:

Capillary flow
Course of capillary flow [kg s/m] (currently only WUFI® 2D).

Capillary flux density
Course of capillary flux density [kg s/m2] (currently only WUFI® 2D).

Diffusion flow
Course of diffusion flow [kg s/m] (currently only WUFI® 2D).

Diffusion flux density
Course of diffusion flux density [kg s/m2] (currently only WUFI® 2D).

Heat flow
Course of heat flow [W/m] (currently only WUFI® 2D).

Heat flux density
Course of heat flux density [W/m2] (currently only WUFI® 2D).

Isopleths
Relative humidity printed against the temperature for each time step.

Limit water content in M.-%
Limit curve according to WTA-recommendation 6-8 displayed as course of limit water content
for the selected material, a moving daily average is preset.

Relative humidity
Course of relative humidity [%].
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Temperature
Course of temperature [°C].

User defined
User defined definition of output.

Water content in M.-% (mv)
Course of water content in M.-%, a moving daily average is preset.

Water content in M.-%
Course of water content in M.-%.

Water content in Vol.-%
Course of water content in Vol.-%.

Water content in kg/m2

Course of water content in kg/m2 (only WUFI® Pro).

Water content in kg/m3

Course of water content in kg/m3.

Wood moisture WTA
Evaluation of the relative pore air moisture content in the selected layer (WTA-recommendation
6-8), a moving daily average is preset.

In the menu “Module” the display of the results can be selected. This item is only available after
selecting “User defined” in “Current” or “New page” or after changing the “Type” to “User defined”.
Otherwise, the pull-down menu is grayed out. The following modules are available:

Result quantity for selection
Course of the result quantity averaged over the selection.

Flux density along cross section
Course of flux density averaged along cross section.

Flux over cross section
Course of flux over the cross section.

X-Y-Plot for selection
Plots result quantity x against result quantity y for every calculated time step.

Profile along cross section
Profile along cross section for the selected time step of calculation.

The settings which can/have to be set in the different Types/Modules are described in “Area selection
and settings for series”.
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Combined selection (1 cm)

The “Combined selection (1 cm)” allows you to select a predefined area. If the box is checked, the
area at the material boundary which is located closest to the cursor is “premarked” with a width
of about one centimeter (depending on the dimensions of the grid elements in the selection. The
amount which is closest to 1 cm is used). By clicking on the “preselection” with the left mouse
button, the strip is selected respectively deselected.
This selection method was inserted for the assessment according to WTA Recommendation 6-8 -
Assessment of humidity in timber constructions.

4.1 Area selection and settings for series

Each type uses a specific module, which determines the possible way selection and necessary settings.
The types and modules are explained in the following section.

4.1.1 Type: Temperature

The module Result quantity for selection is used. Here the possible settings are described.

4.1.2 Type: Relative humidity

The module Result quantity for selection is used. Here the possible settings are described.

4.1.3 Types: Water content

The modules Result quantity for selection are used. Here the possible settings are described.

4.1.4 Type: Wood moisture WTA

According to WTA-Merkblatt 6-8, the evaluation of wood-destroying fungi in wood is carried out
over the average pore air moisture content of the (critical) 10 mm layer.
The evaluation can only be used for the evaluation of solid wood products, e.g., glued or doweled
solid wood products, solid wood formwork or three-layer panels.
The relative pore air moisture content in the solid wood product must not exceed 95 % at 0 °C and
86 % at 30 °C in the daily mean value. In exceptional cases, single short-term exceedings may be
accepted.
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x-axis: Temperature
y-axis: relative pore air moisture content
Values above the limit: wood decay can occur
Values below the limit: no wood decay

Using the example of a single-layer flat roof with a bright colored roofing felt, the following diagram
results for the lower centimeter of the wooden sheathing:
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In this case all values are lower than the limit. A wood decay is not to be expected here. The limit
is defined beginning with 0 °C, at lower temperatures no wood decay will occur.
For further information see:
WTA Merkblatt 6-8: Feuchtetechnische Bewertung von Holzbauteilen - Vereinfachte Nachweise und
Simulation. WTA Publications. Fraunhofer IRB Verlag. Ausgabe 08.2016/D

4.1.5 Types: Water content in M.-% (mv) and Limit water content in M.-%

Combining this two types it is possible to analyze the course of the water content according to the
limits of the pore water content in WTA-recommandation 6-8. For WTA 6-8 the relative pore air
moisture content in the critical centimeter of the wooden layer is evaluated. In this type the used
limit curve is transferred into a course of limit water content by using the moisture storage function
of the selected layer and the temperature for each time step. According to WTA 6-8, the average
daily values are used for the evaluation.
The combined courses of the types “Water content in M.-% (mv)” and “Limit water content in
M.-%” allows an evaluation of the course of the water content according to WTA-recommendation
6-8. If the water content exceeds the limit water content, wooden decay can occur. Using the
example of a single-layer flat roof with a bright colored roofing felt, the following courses results for
the lower centimeter of the wooden sheathing:
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In this case, no wooden decay is to be expected. The course of the limit water content is not
continuous, since the limits are only defined for temperatures between 0 °C and 30 °C.

Selection

The display of the type “Wood moisture WTA” is done based on the selected grid elements. Ac-
cording to the WTA-recommendation 6-8 the evaluation of the wood-destroying fungi has to be
carried out for a critical 10 mm layer of the wood. For roofs this is usually the bottom 10 mm of the
outer wooden sheathing. For the type “Wooden moisture WTA” the “combined selection (1 cm)”
is switched on, which automatically marks an area with a width or height as close as possible to
10 mm (see also “Area selection and settings for series”).

The following settings can be adapted when choosing the type “Wooden moisture WTA”:
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Result quantity X
Preset with temperature.

Result quantity Y
Preset with relative humidity.

Title
Title of the diagram. This is set by creating the first series and is ignored while further series
are added to the diagram.

Series name
Name of the series. The curve name is displayed in the user defined tree and the legend of
the diagram.

Start color, Middle color, End color
As the X-Y-plot does not contain a time axis, the time can be included by using a changing
color. The dots are colored starting at the start date with the start color. Then a color
gradient is created changing from start color over middle color to end color. The last end date
is displayed in the color set under end color

X-Axis label
Label of the domain axis.

Y-Axis label
Label of the range axis.

Start date
Start date of the evaluation period. The start date must be included in the calculation
respectively result file period.

End date
End date of the evaluation period. The start date must be included in calculation respectively
result file period.

Display WTA limit
Displays the limit relative humidity according to WTA-recommendation 6-8.

Average mode
Preset with “Moving time average”.

Window size
Preset with “24” (daily mean value).
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4.1.6 Type: Isopleths

The Isopleths diagram shows relative humidity plotted against the temperature for each calculated
time step. This graph allows a quick assessment of the possibility of mold growth. If all states
below the corresponding LIM, mold is not expected. Otherwise, more detailed evaluations should
be performed.
LIM I: Bio-utilizable substrates, such as wall paper, plaster board, building products made of biolog-
ically degradable materials, materials for permanently elastic joints, strongly contaminated surfaces
etc.
LIM II: Less bio-utilizable substrates with porous structure, such as plasters, mineral building mate-
rials, certain woods, insulating materials not belonging to group I.
Note: The LIMs where determined and validated for the indoor surfaces. For positions interior of
constructions they should only be used with care.
For further information see WUFI® Pro Help, WUFI® Bio Help or Sedlbauer, K.: Prediction of
mould fungus formation on the surface of and inside building components. Dissertation, University
Stuttgart, 2001

Selection

The display of the type “Isopleths” is done based on the selected grid elements. It is possible to select
several areas. The respective value for each time is the average over all selected grid elements.

The selected areas are marked in the complementary color of the material. By moving the mouse
over the selection, information on the coordinates and dimensions are displayed. If different materials
are selected, a warning message is displayed.
The following settings are required when choosing the type “Isopleths” for the type “User defined”:

Result quantity X
Preset with temperature.

38



Result quantity Y
Preset with relative humidity.

Title
Title of the diagram. This is set by creating the first series and is ignored while further series
are added to the diagram.

Series name
Name of the series. The curve name is displayed in the user defined tree and the legend of
the diagram.

Start color, Middle color, End color
As the X-Y-plot does not contain a time axis, the time can be included by using a changing
color. The dots are colored starting at the start date with the start color. Then a color
gradient is created changing from start color over middle color to end color. The last end date
is displayed in the color set under end color.

X-Axis label
Label of the domain axis.

Y-Axis label
Label of the range axis.

Start date
Start date of the evaluation period. The start date must be included in the calculation
respectively result file period.

End date
End date of the evaluation period. The start date must be included in calculation respectively
result file period.

Display LIM functions
Displays the LIM functions in the diagram (LIM = Lowest Isopleth of mold).

Average mode
The average mode setting allows to form averages over a time window of selectable size. The
possibilities “No average”, “Time average” and “Moving time average” are available. If one
of the two average modes is chosen, the “window size” for the time window can entered.
The value “window size” is related to the selected unit of time of the result file (usually
hours). Using the “Time average”, the average is calculated for the values included in the
time window. The result is a step course. Using the “Moving time average” the average is
calculated including half the window before the particular point and half of the window behind
and assigned to that point. In this case the displayed course will start after half the windows
size time and end half the window size before the end of the data.

4.1.7 Type: Diffusion flux

The module Flux over cross section is used. Here the possible settings are described.
This type is currently only available for WUFI® 2D result files.
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4.1.8 Type: Diffusion flux density

The module Flux density along cross section is used. Here the possible settings are described.
This type is currently only available for WUFI® 2D result files.

4.1.9 Type: Capillary flux

The module Flux over cross section is used. Here the possible settings are described.
This type is currently only available for WUFI® 2D result files.

4.1.10 Type: Capillary flux density

The module Flux density along cross section is used. Here the possible settings are described.
This type is currently only available for WUFI® 2D result files.

4.1.11 Type: Heat flux

The module Flux over cross section is used. Here the possible settings are described.
This type is currently only available for WUFI® 2D result files.

4.1.12 Type: Heat flux density

The module Flux density along cross section is used. Here the possible settings are described.
This type is currently only available for WUFI® 2D result files.

4.1.13 Type: User defined

The type “User defined” allows the user to select the used module. The possible settings are
described for the individual modules.

4.1.14 Module: Result quantity for selection

The module result quantity for selection allows to create a course of the quantity. The values of
quantity are averaged over the selection. This module is automatically enabled when you insert a
series of the type temperature, relative humidity and water content.

Selection

The display of the module “Result quantity for selection” is done based on the selected grid elements.
It is possible to select several areas. The respective value for each time is the average over all selected
grid elements.
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The selected areas are marked in the complementary color of the material. By moving the mouse
over the selection, information on the coordinates and dimensions are displayed. If different materials
are selected, a warning message is displayed.
The following settings are required when choosing the module “result quantity” for the type “User
defined”:

Result quantity
The following result quantities can be selected for the series:

• Temperature in °C
• Relative humidity in %
• Water content in kg/m2 (only for WUFI® Pro result files)
• Water content in kg/m3

• Water content in M.-% (percent by mass)
• Water content in Vol.-% (percent by volume)
• Vapor pressure in hPa (only for WUFI® 2D result files)

Note for WUFI® 2D result files: Only result quantities can be shown which are included in
the selected result file.

Title
Title of the diagram. This is set by creating the first series and is ignored while further series
are added to the diagram.

Series name
Name of the series. The curve name is displayed in the user defined tree and the legend of
the diagram.

Color
Color for displaying the series. There are several color models available.

X-Axis label
Label of the domain axis.
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Y-Axis label
Label of the range axis.

Start date
Start date of the evaluation period. The start date must be included in the calculation
respectively result file period.

End date
End date of the evaluation period. The start date must be included in calculation respectively
result file period.

Average mode
The average mode setting allows to form averages over a time window of selectable size. The
possibilities “No average”, “Time average” and “Moving time average” are available. If one
of the two average modes is chosen, the “window size” for the time window can entered.
The value “window size” is related to the selected unit of time of the result file (usually
hours). Using the “Time average”, the average is calculated for the values included in the
time window. The result is a step course. Using the “Moving time average” the average is
calculated including half the window before the particular point and half of the window behind
and assigned to that point. In this case the displayed course will start after half the windows
size time and end half the window size before the end of the data.

Note: If the type result quantity is chosen directly, the fields are already preassigned with text or
values.

4.1.15 Module: Flux density along cross section

The module flux density along cross section allows printing a course of the average flux density along
a set cross section. The flux density is determined using the interface between two or more elements.
The values are averaged over the length of this cross section. This module is automatically enabled
when you insert a series of the type flux density. This module is currently only available for WUFI®
2D result files.

Selection

The evaluation of the flux density is determined between two grid elements along a cross section.
For setting the section a grid element junction is chosen and then horizontally or vertically of it a
second point. By clicking on one of the points it can be deleted. The section can be shortened by
clicking on the section line or be extended by clicking on the extension of the section.

42



For easier selection of the section in the computational grid, additional functions ( additional to
“Area Selection / Settings”) can be called by a right mouse click:

Catch Mouse
If this function is activated, the mouse pointer will be attracted to the individual points,
making it easier to select them.

Show catching points
Shows the points in the computational grid that can be selected to define the section.

The following settings are required when choosing the module “flux density” for the type “User
defined”:

Result quantity
The following result quantities can be selected for the series:

• Heat flux density [W/m2]
• Diffusion flux density [kg/m2 s]
• Capillary flux density [kg/m2 s]

Note for WUFI® 2D result files: Only result quantities can be shown which are included in
the selected result file.

Title
Title of the diagram. This is set by creating the first series and is ignored while further series
are added to the diagram.

Series name
Name of the series. The curve name is displayed in the user defined tree and the legend of
the diagram.
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Color
Color for displaying the series. There are several color models available.

X-Axis label
Label of the domain axis.

Y-Axis label
Label of the range axis.

Start date
Start date of the evaluation period. The start date must be included in the calculation
respectively result file period.

End date
End date of the evaluation period. The start date must be included in calculation respectively
result file period.

Average mode
The average mode setting allows to form averages over a time window of selectable size. The
possibilities “No average”, “Time average” and “Moving time average” are available. If one
of the two average modes is chosen, the “window size” for the time window can entered.
The value “window size” is related to the selected unit of time of the result file (usually
hours). Using the “Time average”, the average is calculated for the values included in the
time window. The result is a step course. Using the “Moving time average” the average is
calculated including half the window before the particular point and half of the window behind
and assigned to that point. In this case the displayed course will start after half the windows
size time and end half the window size before the end of the data.

Note: If the type flux density is chosen directly, the fields are already preassigned with text or values.

4.1.16 Module: Flux over cross section

The module flux over cross section allows printing a course of the summed flux over a defined cross
section. The flux is determined using the interface between two or more elements. The values are
summed up over the length of the cross section. This module is automatically enabled when you
insert a series of the type flux. This module is currently only available for WUFI® 2D result files.

Selection

The evaluation of the flux is determined between two grid elements along a cross section. For setting
the section a grid element junction is chosen and then horizontally or vertically of it a second point.
By clicking on one of the points it can be deleted. The section can be shortened by clicking on the
section line or be extended by clicking on the extension of the section.
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For easier selection of the section in the computational grid, additional functions ( additional to
“Area Selection / Settings”) can be called by a right mouse click:

Catch Mouse
If this function is activated, the mouse pointer will be attracted to the individual points,
making it easier to select them.

Show catching points
Shows the points in the computational grid that can be selected to define the section.

The following settings are required when choosing the module “flux” for the type “User defined”:

Result quantity
The following result quantities can be selected for the series:

• Heat flow [W/m]
• Diffusion flow [kg/m s]
• Capillary flow [kg/m s]

45



Note for WUFI® 2D result files: Only result quantities can be shown which are included in
the selected result file.

Title
Title of the diagram. This is set by creating the first series and is ignored while further series
are added to the diagram.

Series name
Name of the series. The curve name is displayed in the user defined tree and the legend of
the diagram.

Color
Color for displaying the series. There are several color models available.

X-Axis label
Label of the domain axis.

Y-Axis label
Label of the range axis.

Start date
Start date of the evaluation period. The start date must be included in the calculation
respectively result file period.

End date
End date of the evaluation period. The start date must be included in calculation respectively
result file period.

Average mode
The average mode setting allows to form averages over a time window of selectable size. The
possibilities “No average”, “Time average” and “Moving time average” are available. If one
of the two average modes is chosen, the “window size” for the time window can entered.
The value “window size” is related to the selected unit of time of the result file (usually
hours). Using the “Time average”, the average is calculated for the values included in the
time window. The result is a step course. Using the “Moving time average” the average is
calculated including half the window before the particular point and half of the window behind
and assigned to that point. In this case the displayed course will start after half the windows
size time and end half the window size before the end of the data.

Note: If the type “flux” is chosen directly, the fields are already pre-assigned with text or values.

4.1.17 Module: X-Y-Plot over selection

The module “X-Y-Plot over selection” allows to create a course of one quantity over another quantity.
Hereby, result quantity X is used as domain axis and result quantity Y as range axis. For every time
step in the result file one point is displayed.
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Selection

The display of the module “X-Y-Plot over selection” is done based on the selected grid elements. It
is possible to select several areas. The respective value for each time is the average over all selected
grid elements.

The selected areas are marked in the complementary color of the material. By moving the mouse
over the selection, information on the coordinates and dimensions are displayed. If different materials
are selected, a warning message is displayed. The following settings are required when choosing
the module “X-Y-Plot over selection” for the type “User defined”:

Result quantity X, Result quantity Y
The following result quantities can be selected for the series:

• Temperature in °C
• Relative humidity in %
• Water content in kg/m2 (only for WUFI® Pro result files)
• Water content in kg/m3

• Water content in M.-% (percent by mass)
• Water content in Vol.-% (percent by volume)
• Vapor pressure in hPa (only for WUFI® 2D result files)

Note for WUFI® 2D result files: Only result quantities can be shown which are included in
the selected result file.

Title
Title of the diagram. This is set by creating the first series and is ignored while further series
are added to the diagram.
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Series name
Name of the series. The curve name is displayed in the user defined tree and the legend of
the diagram.

Start color, Middle color, End color
As the X-Y-plot does not contain a time axis, the time can be included by using a changing
color. The dots are colored starting at the start date with the start color. Then a color
gradient is created changing from start color over middle color to end color. The last end date
is displayed in the color set under end color.

X-Axis label
Label of the domain axis.

Y-Axis label
Label of the range axis.

Start date
Start date of the evaluation period. The start date must be included in the calculation
respectively result file period.

End date
End date of the evaluation period. The start date must be included in calculation respectively
result file period.

Display LIM functions
Displays the LIM functions in the diagram (LIM = Lowest Isopleth of mold).
See also Type: Isopleths.

Average mode
The average mode setting allows to form averages over a time window of selectable size. The
possibilities “No average”, “Time average” and “Moving time average” are available. If one
of the two average modes is chosen, the “window size” for the time window can entered.
The value “window size” is related to the selected unit of time of the result file (usually
hours). Using the “Time average”, the average is calculated for the values included in the
time window. The result is a step course. Using the “Moving time average” the average is
calculated including half the window before the particular point and half of the window behind
and assigned to that point. In this case the displayed course will start after half the windows
size time and end half the window size before the end of the data.

4.1.18 Module: Profile along cross section

Allows to display the profile of a quantity for a set time for over the length of a section. The selected
result quantity is displayed over the length of the section. The length of the section is defined as
positive in the calculation grid from left to right or from bottom to top (that means that the origin
is on the bottom left).

Selection

The creating of the profile is determined using a cross section through the wished number of grid
elements. For selection first one grid element is chosen followed by clicking on a second one
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horizontally or vertically to the first one. By clicking on one of the points it can be deleted. The
section can be shortened by clicking on the section line or be extended by clicking on the extension
of the section line.

For easier selection of the section in the computational grid, additional functions ( additional to
“Area Selection / Settings”) can be called by a right mouse click:

Catch Mouse
If this function is activated, the mouse pointer will be attracted to the individual points,
making it easier to select them.

Show catching points
Shows the points in the computational grid that can be selected to define the section.

The following settings are required when choosing the module “Profile” for the type “User defined”:

Result quantity
The following result quantities can be selected for the series:

• Temperature in °C
• Relative humidity in %
• Water content in kg/m2 (only for WUFI® Pro result files)

49



• Water content in kg/m3

• Water content in M.-% (percent by mass)
• Water content in Vol.-% (percent by volume)
• Vapor pressure in hPa (only for WUFI® 2D result files)

Note for WUFI® 2D result files: Only result quantities can be shown which are included in
the selected result file.

Title
Title of the diagram. This is set by creating the first series and is ignored while further series
are added to the diagram.

Series name
Name of the series. The curve name is displayed in the user defined tree and the legend of
the diagram.

Color
Color for displaying the series. There are several color models available.

X-Axis label
Label of the domain axis.

Y-Axis label
Label of the range axis.

Date
Date of profile. The date must be included in the calculation respectively result file period.

Average mode
The average mode setting allows to form averages over a time window of selectable size. The
possibilities “No average”, “Time average” and “Moving time average” are available. If one
of the two average modes is chosen, the “window size” for the time window can entered.
The value “window size” is related to the selected unit of time of the result file (usually
hours). Using the “Time average”, the average is calculated for the values included in the
time window. The result is a step course. Using the “Moving time average” the average is
calculated including half the window before the particular point and half of the window behind
and assigned to that point. In this case the displayed course will start after half the windows
size time and end half the window size before the end of the data.

4.1.19 Type/Module: Isoline

The Isoline allows a two- and three-dimensional view of lines of equal value displayed in or over the
construction for one time step. In the three-dimensional view the grid and the isolines are displayed
above the base as a height corresponding to the value of quantity (3D profile).
Note: The Isoline can only be chosen directly in the main windows “User defined” section. The
Isoline is only available for WUFI® 2D results files.
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Selection

The display of the type “Isoline” is done based on the selected grid elements. For the display of the
Isoline in most cases it will make sense to select the total construction. It is also possible to select
several areas.

The selected areas are marked in the complementary color of the material. By moving the mouse
over the selection, information on the coordinates and dimensions are displayed. If different materials
are selected, a warning message is displayed.
The following settings are required when choosing the type “Isopleths” for the type “User defined”:

Result quantity
The following result quantities can be selected for the series:

• Temperature in °C
• Relative humidity in %
• Water content in kg/m2 (only for WUFI® Pro result files)
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• Water content in kg/m3

• Water content in M.-% (percent by mass)
• Water content in Vol.-% (percent by volume)
• Vapor pressure in hPa (only for WUFI® 2D result files)

Note for WUFI® 2D result files: Only result quantities can be shown which are included in
the selected result file.

Title
Title of the diagram. This is set by creating the first series and is ignored while further series
are added to the diagram.

Start color, End color
To differentiate the values, the isoline is created using a color gradient. The start color
corresponds to the lowest value of the result quantity and the end color to the highest value.

X-Axis label
Label of the domain axis.

Y-Axis label
Label of the range axis.

Number of contour levels
Specifies the number of contour lines displayed in the diagram. The lines are uniformly
distributed over the range of the result.

Draw grid
Determines whether the computational grid is displayed with the isolines or not.

Date
Date of profile. The date must be included in the calculation respectively result file period.

Average mode
The average mode setting allows to form averages over a time window of selectable size. The
possibilities “No average”, “Time average” and “Moving time average” are available. If one
of the two average modes is chosen, the “window size” for the time window can entered.
The value “window size” is related to the selected unit of time of the result file (usually
hours). Using the “Time average”, the average is calculated for the values included in the
time window. The result is a step course. Using the “Moving time average” the average is
calculated including half the window before the particular point and half of the window behind
and assigned to that point. In this case the displayed course will start after half the windows
size time and end half the window size before the end of the data.

Note: Except for the result quantity the values are preset. For the date the last time step of
calculation is preset.
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5 Templates

Templates allow to save a graph project independent of the source file. This way it is possible to
re-open the evaluation later using a different or newly calculated source file and display the same
series and pages for a new source file.
Note: Does not work with multiple result files in one project! Furthermore, the computational grid
must not change. This feature is useful for parameter variations of a component to produce the
same diagrams of various calculations repeatedly.
The creation of the templates have so far only been tested for WUFI® 2D result files!

5.1 Load template . . .

Load a template for the evaluation. File extension *.w2t

After selecting the template file to load, a window opens for selection of the result file to process.
To do this, change to the desired project directory:
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If the template contains automatic export data, you can decide to perform this export while opening
or not:

If the question is answered with “Yes” the automatic exports are carried out after loading the
diagrams.

5.2 Save as template . . .

5.2.1 with automatic ASCII export

WUFI Graph can automatically export data of series in a text file (ASCII), if this export is defined
while saving the template. For this the question about setting up an automatic ASCII export has to
be answered with “Yes”.
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Here the automatic ASCII exports can be defined to be applied when opening the template.
Procedure:

• Select diagram or series from left tree.

• Press the “Add” button, the desired export appears in the right pane (For deleting select line
in right pane and click “remove”).

• Enter file name and path for export (here exportfile_xxx is used).

• Clicking “File” allows specifying or selecting the template file name (file extension is *.w2t).

• “Save” saves the template containing the export information.

5.2.2 without automatic ASCII export

If you do not want to automatically export data, choose “No”.
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A window opens to specify or select the template file name.

WUFI Graph templates have the file extension *.w2t.
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6 Settings

6.1 Tab: Settings Chart

In this menu the basic settings for the use of the program can be set.

Remember grid positions
Remembers the for displaying selected grid elements in the “Area Selection / Settings”. This
setting enables the rapid generation of further result quantities for the previously selected area.
Note: The selection is maintained only as long as the grid does not change. If another result
file is selected, the selection will reset.

Update interval drawing diagram [%]
Interval which is used to refresh diagram while reading the data from the result file.

Font size diagram title
Font size setting for the diagram title in the page view/main window.

Font size legend
Font size setting for the diagrams’ legend.

Font size axes labels
Font size setting for the axes labels.
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Font size axes scales
Font size setting for the scaling of the axes.

Subdivisions for automatic scaling
Number of subdivisions for automatic axis scaling.

Default date format
Preset of the date format for the axis label, time selection etc.

Default export format
Preset of the date format for export file.

Date formats
Date formats allows to predefine formats for displaying the date. The list corresponds to
the pull-down menu “Default date format” and “Default export format” available entries and
order. With “Add” user defined date formats can be inserted. With “Remove” a selected
entry will be deleted. The position of the entries in the list can be changed with the “up” and
“down” buttons or with drag and drop.

6.2 Tab: Settings Isoline

Remember grid positions
Remembers the for displaying selected grid elements in the “Area Selection / Settings”. This
setting enables the rapid generation of further result quantities for the previously selected area.
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Note: The selection is maintained only as long as the grid does not change. If another result
file is selected, the selection will reset.

Use Java-Swing components (compatibility mode but slower)
Display mode for 3D graphics. If problems displaying appear using older PCs, this mode should
be turned on. The presentation may not be completely liquid in this mode.

Increment/Decrement used for control
Increment, which is used for rotation and scaling of the 3D graphics.
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